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Drivers are not forever
Are your drivers the latest available? Your
modem needs the right drivers for optimum
performance. If you�re like most people, you
probably haven�t the foggiest idea what driv-
ers are installed on your system. Visit your
modem manufacturer�s Web page to down-
load the latest drivers. The driver file you
download will generally be an executable
(EXE) file or compressed as an installation
(INF) file. Moreover, you could also sub-
scribe to driver sites so that you are auto-
matically informed about updates. 

Go digital
Often the modem is set to pulse dialling
when tone dialling would be faster and
more efficient. Check if your telephone
exchange supports it. TCP/IP accounts
work better with tone lines whereas Shell

accounts seem to work better with pulse
lines. Be prepared to face numerous
dropped carriers if you have a TCP/IP
account and a pulse line.

Buzz off! 
If you enable the �call waiting� feature pro-
vided by many phone exchanges, your
dial-up connection to the Internet may be
interrupted if you receive a phone call in
the middle of a session. Unless you are
expecting any really urgent calls, disable
the call waiting option.

Cache and carry
Use cache effectively. By default, most
browsers are set to automatically check for
updated pages and use the cache accord-

ingly. You could turn this feature off and
set the browser to always use the cache.
Manually refresh the page when you want
to check for updates.

Do not check for newer version of the
cached pages too often. Pages on the Inter-
net are, on the average, updated every 40
to 50 days. Depending on the content of
the site, you may not need to view the lat-
est version of the page, and can access the
page directly from your cache. In Netscape
Navigator go to Edit > Preferences >
Advanced > Cache menu and click �never�
for the option �Document in cache is com-
pared to document on network�. In Inter-
net Explorer go to View > Options >
General > Temporary Internet Files > Set-
tings button and click �never� for the
option �Check for newer version of the
page�. To see the latest version of the page
you can always click the Reload or
Refresh button on the top bar of your

Any surfer in India will know the
woes associated with getting on to
the Internet. The phone lines seem

to be perpetually busy. 
Then of course, there are the fre-

quent disconnections.
If possible, go online when 
there is least Net traffic.
This would typically be between

midnight and 5 a.m. During these
off-peak hours, not only is tele-
phone traffic relatively low, but
reconnecting after a dropped 

carrier is much faster too.
As for the side-effects�stumbling

into class (or office) yawning 
and bleary-eyed� well, you can�t

have everything going the way 
you want, can you?

Illustrations: G.

Perhaps the most common question among Internet surfers today is �How can I speed up my Internet

connection?� You can, to a certain extent, tweak your hardware and software to ensure that they give

you the best performance possible. It also helps if you are familiar with various unpublicised hints

that help you get the most out of your time online. Want to make the Net sizzle? You�ve come to the right

place... let�s get going! 

AVOID TRAFFIC JAMS
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browser.

For starters
Is there a page you visit frequently? Set it
as your home page. Most likely, this
would be the home page of your
favourite search engine. However, if your
browser takes a long time to load, then it
is best to keep a blank page on the local
hard disk as the start page. The cache
will take charge of loading the page 
for you.

Nix to multimedia
Turn off multimedia features in your

browser if you don�t require them. Manu-
ally display pictures that you need to see.
However, if you often need to see almost
all the pictures, leave this option on, as
this will be faster. Your browser will start
downloading all pictures simultaneously
rather than one at a time.

Have your cake and�
See an interesting link on a page, but still
want to continue reading the page you
are on? Just right-click on the link and
choose the �Open link in new window�
option. 

Alternatively, you can press the Shift key
while clicking on the link�this will also
open it in a new window. You may then
resize both windows to your liking and
continue browsing. If you are using a low
resolution display (640 x 480 or 800 x
600) you may want to keep the windows
full size and switch between the two.

Rev it up
Use acceleration software for browsing�
this starts collecting information about
links as soon as the page has loaded.
One example is Got It!, from Go Ahead
Software, which lets you specify which
pages to preload, supports off-line
browsing and gives you a hyperlinked
list of sites that have been cached by 
the program for even easier access to 
preloaded pages. 

Note that, with most accelerators, if
your system crashes or if you unload the
browser and accelerator in the wrong
order, you may not be able to access the
Internet through your browser unless you
start up the accelerator again or reset the
browser option that tells the browser to
use a proxy server.

Get it right
Use resuming software such as GetRight
from HeadLight software. If a site offers
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Make sure your COM por t uses
16550 UART to make best use 
of FIFO (First In First Out) buffers. 
The 16550 UART is a chip on the
integrated motherboard which han-
dles serial data buffering, and the
speed of this chip is 110Kbps. 
It makes sure that the data which
comes in first is processed first
and sent out first. Older machines
had the 8250 UART chip which
was much slower�about half as
fast as the 16550 UART.

UART TO DO THIS

CoverStory dialup june.qxd  11/29/99  3:46 PM  Page 153



154 June 1999

connect
Dial-up

more than one server, find the one that is
nearest to you (or has the least traffic) to
get the fastest connections.

Ban the banners!
Software like AdsOff and PopOff95

prevent advertisement windows from
opening up. This speeds up browsing.

Mail checker to
the rescue

Want to keep your Internet connection
alive while you are away from the com-
puter, but don�t fancy running a special
program that uses up precious resources?
Open your e-mail program, and tell it to
check your e-mail once every minute (or
the minimum limit) under Options. This
way, it keeps information going back and
forth between you and the server, while
doing something useful as well.

Smart browsing
If you type in more than one word in the
little bar window at the top of your brows-
er meant for entering addresses, the words
are sent as a query to a randomly selected
search engine. This saves the time that you
spend in going to a search engine site and
waiting for the page to load before start-
ing your search. Try typing �hotmail� for
the browser to take you to http:// www.
hotmail.com. The latest editions of IE and
Communicator let you type common
terms into the location fields and the
browsers will take you to sites with that
URL�or at least a close match. 

Your URLs are numbered
If you know the IP address of a site, type
that instead of the URL for faster access.
For instance, try going to 206.86.11.206
instead of www.chip-india.com.

1/4 page Ad 1/4 page Ad

RUN FOR IT
Get to a favourite site almost instantly with the
Windows 95 Run program. From the Start 

button, select Run and type the complete URL
for a favourite site. Windows will launch your

default Web browser and go
right to the site. You can also
have an address bar next to
the Quick Launch bar in Inter-
net Explorer or Windows 98.
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No password, please
In the no-Password mode, the dial-up net-
working is unable to save the password
and remember it. You can get around this
by going to Settings > Control Panel and
then to Passwords. Once there, set it so
that you can personalise the desktop.
Now, when you shut down windows,
there will be another option, Log on as

another user. In this mode, you will be
able to Remember Password, so the Dial-
up networking will be remembered. Enter
your password and save it. Once it has
been saved, go back to Password and
change the configuration to Anyone can
use the same settings of the Desktop,
and don�t use any password at all. Win-
dows will now switch back to the normal
mode, but the Dial-up Networking save

password is unchanged. So, your pass-
word is now saved and you won�t have to
type it in again 

Chat away
IRC clients such as mIRC and Pirch are
better than Web-based chat programs like
EZPro. For chatting, find out if the site has
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If you are in India, it makes sense to download from a server in the US rather than one in India
or anywhere else in Asia�Japan is probably the only exception. The notion of geographical 
proximity is irrelevant in because the vast majority of sites are housed on servers in the US.

PATRIOTISM DOES NOT ALWAYS PAY
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an IRC server and use that instead of Web-
based chat. If only Web-based chat is
available, give preference to Java over
HTML, if the option is provided. 

Browse offline
Offline Browsing Programmes can be 
set to go
online and

download a site 
on schedule ready for reading later.
Microsoft Internet Explorer 5.0 can be
used for this,  or you could try Web 
Wacker (www.bluesquirrel.com/wacker),
Freeloader (www.freeloader.com) or Web
Buddy (www.dataviz.com)

The crumbling cookie
A cookie is little more than a string of
characters written to a file on your hard
disk. Only the server which pushed the
cookie to your machine can read the con-
tents of this file and helps identify you�
your computer, rather�on subsequent
visits. Though generally harmless, some
servers can be programmed to read other
servers� cookies, thus tracking your
browsing habits and online movements. 

Truly anonymous FTP
If you still use an FTP client program to
download files (and many of us do), make
certain that it is set to give a bogus pass-
word, like anonymous@unknown.com. If
your browser lets you, turn off the feature
that sends your e-mail address as a pass-
word for anonymous FTP sessions.

Travel incognito
A straightforward approach to Web 
privacy is to temporarily remove your 
personal information from your browser.
This is especially advised when browsing
new sites. After you remove details such
as your real name and genuine e-mail
address from your browser, the only info
a Web site can sniff out is your ISP�s
address and geographical location. Fat lot
of good that will do them!

Get around passwords
Search engines cannot penetrate sites that
are protected by passwords or otherwise
hard to get to--but you can, thanks to
w w w.internets.com. The site indexes
thousands of databases on the Web and
lets you get at them by keyword search or
by browsing an alphabetical index. You
can also use it as a jumping-off spot to
other search engines.

Ever wish you could have a handy list of all
the Web sites you most recently visited? If
you use Internet Explorer, it�s easy. In Win-
dows 95 or NT, start Windows Explorer and
navigate to C: > Windows > Start
Menu. Right-click on Explorer�s right pane.
Choose New Folder. Type in this new name:
Internet History.{FF393560-C2A7-11CF-
BFF4-444553540000} and hit Enter. You
must type the numbers in braces exactly as
they appear here. Click on the Start button,
then choose Internet History. All your most
recently visited URLs will fly out to the right
of the menu. Click on one, and Internet
Explorer will spring into action, loaded with
the specified page!

WEB SIGHTING

Wondering which country or state a partic-
ular Internet site is located in? Try
http://205.177.25.9/cgi-bin/whois?
For example, to find out where Netscape
(netscape.com) site is located, point your
Web browser to http://205.177.25.9/cgi-
bin/whois?netscape.com. 

WHERE IN THE WORLD?

You can create your own custom shortcuts to
Internet sites using Notepad. This is how you
do it: Click the Start button. Select Programs.
Select Accessories. Click on Notepad. 
Type these lines in your Notepad document: 
[InternetShortcut]
URL=http://www.yoursite.com
Now, save the file with a .URL extension

A SHORTCUT TO SHORTCUTS
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Java is
full o�
beans, but...
Java and JavaScript applets make Web
pages look real cool. However, they can
also take control of your browser.
JavaScript can send you to a Web page you
didn�t select, open a new pre-addressed e-
mail message, or send internal commands
to your browser--all without your having
selected or clicked on anything. So, while
you�re modifying your browser�s settings,
you might want to disable Java and
JavaScript too. Some pages may look less
snazzy, but the increased security is prob-
ably worth it.

Mind that URL
If you are tired of checking up on your
favourite Web pages just to see if they
have changed since the last time you vis-

ited them, why not let a program like
URL-Minder (a free service provided by
NetMind) do the checking for you?

Sharing favourites
Internet Explorer Favorites, known as
Bookmarks in Netscape Navigator, are a
convenient way to organise and link to
Web sites that you visit frequently. Your
Netscape Bookmarks are automatically
imported when you install Internet
Explorer. On the Favorites menu, click
the Imported Bookmarks folder to view
them. If you use Internet Explorer on sev-
eral computers, you can easily share
Favorites between computers by import-
ing them. Also, if you use both Internet
Explorer and Navigator, you can keep
your Favorites and Bookmarks up-to-date
with each other by importing them
between programs. To import Bookmarks
or Favorites, click the File menu, and
then click Import and Export. To export
Favorites to Bookmarks, or Favorites on

the same or another computer, click the
File menu, and then click Import and
Export.

157

AD

A generic search phrase like �round table� will
yield too many results-especially from

Rotary Clubs worldwide-if you�re trying to
unearth information about Arthur�s
famous furniture. A better phrase would

be �king arthur knights round table�.

CHOOSE YOUR WORDS WISELY
Put quotation marks around specific, verba-
tim phrases that you want to find exactly as
written: �blood, toil, tears and sweat�. This
will take you to the famous quotation rather
than to sites concerning butchers� shops,
labour unions, sentimental films or aerobic
classes. In HotBot, you can specify the
same in a drop-down menu instead. The
screenshot below shows the result of
checking out the �most-visited page� for the
search string�we were bang on target!

QUOTE, UNQUOTE
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Newsgroup basics
Subscribe to Newsgroups and Listservs
relating to the information you require. You
will be amazed at the amount of informa-
tion you can get from many of them. News-
groups make up Usenet, which you can
think of as being part of the Internet.Each
newsgroup, which is really a discussion
string that comprises a series of related
messages, covers a particular topic that is
often alluded to in its name. Each message
responds to an earlier message or
addresses the overall newsgroup topic in
some way. An advantage here is you nor-
mally have an option of downloading only
headers. You can later download specific
messages. You can also post specific queries
and typically expect results in a couple of
hours or less. You can post your own mes-
sage in response to the messages that
interest you most. 

Trace Internet connections
There is a hidden Internet tool for DOS,
called Tracert. This program will trace an
Internet connection. To use this: Click the
Start button. Select Programs and click
on the MS-DOS button. Once you are 
at the DOS prompt, type: tracert
w w w.anysite.com and press Enter.
(Where www.anysite.com is the site you

wish to access). You could also use a pro-
gram like NeoTrace (www.neoworx.com)
to display links being used and which of
t h e m
are slowing down the process. Find infor-
mation about the routers and computers
on the way. Now you know whom to
blame for that exasperatingly slow 
download!

1/4 page Ad 1/4 page Ad

E-MAIL PLUS
If your e-mail client is also a
newsreader, you can use it to
subscribe to, read messages
from, and post messages to
newsgroups�online discus-
sions on practically any topic. In
Internet Explorer, access the Go
menu and simply select News. IE
automatically launches Outlook
Express if that is set as the default
news reader and opens your
newsgroups folder so you can
get down to business.
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Peek-a-boo!
Wouldn�t it be fun to peer over others�
shoulders and spy on what they are
searching for on the Internet? Well, with
MetaCrawler�s spybot, MetaSpy, you can
do just that. Find out the top search
queries of the moment. The unfiltered ver-
sion at w w w.metaspy.com/spy/warning-
top exposes you to potentially racy stuff,
so be warned. The squeamish can check
out the censored version at
www.metaspy.com/spy/filtered.html.

A really full screen
You can run practically any version of
Internet Explorer in kiosk mode. Kiosk
mode will run the browser in full screen
mode without any toolbar buttons or
menu bars. To do this: Click the Start but-
ton. Click Run. In the Open field, type 
iexplore -k <page> and click O K. Substi-
tute the URL of the page you want to go to
in place of <page>. Of course, you need
to be thoroughly familiar with IE short-
cuts if you are to get any benefit out of

this.

An animated performance
If you saved an animated GIF from a Web
site to you hard drive, you probably won�t
be able to see the animation if you open it
in another graphics program such as Pho-
toshop. To view the animation, simply use
Internet Explorer.
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Install a proxy server software even if the
machine is a standalone one and set your
browser to take the connection from this. A
proxy acts as a buffer between you and the
Web. This assures, both anonymity as well
as greater speed in browsing.

SURF BY PROXY+ OR � 
Search engines like AltaVista and
Lycos let you use symbols such as
+ (plus) and � (minus) to force a
word to appear in a document, or to
eliminate it. Searching for +chip
+potato �computer �electronic will
let you zoom in on pages devoted to
wafers of the edible kind. If you don�t
know the URL, searching for +chip
+computer +magazine +india
�potato �chocolate �calories will
bring up pages relating to� well,
you-know-who. We tried this search,
and were gratified to find that, in spite
of the large number of pages thrown
up, the very first match indeed had
something to do with CHIP.
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Slim is beautiful
Take a break from convention and try the
new Opera browser. The only real alter-
native to Microsoft�s Internet Explorer
and Netscape�s Communicator, Opera is
faster than either and is slim enough to
fit in a single floppy. Though you will have
to give up extras like Java and ActiveX
(which, if required, can be enabled by
extra components), Opera offers features
such as the ability to open multiple pages
in a single window.

Information overload?
The Internet holds so much information�
and misinformation�that nothing short
of a heroic expedition will enable you to
find what you are looking for. Random
searching is the quickest way of scouring
for information-and also the most ineffi-
cient. The information is out there, right
enough, but you can reduce your search-
ing time if you use tips and shortcuts such
as the ones given below. 

Fast results 
Stick to familiar sites when hunting for
information. This will not only pick up
pages from the cache, but navigation will
be faster too. Though most search engines
look the same, they generally accept
advanced queries in different ways. Also,
some of them offer extra features such as
lists of categorised links. Don�t hesitate to
try out different search engines to see
which one you are most comfortable with.

Map your moves
If the site you are browsing has a site map,
go there directly. Navigation from site
maps is usually faster�you can generally
get to where you want with just a single
click. 

Lower case�always!
This will bring up documents that have
both capitals and small letters. Entering
search words in capitals will force the
search results to be case sensitive. Hence,
searching for �chocolate chip cookies� is a
better idea than hunting for �Chocolate
Chip Cookies�, punctilious as you may be
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CHANGE OF MAIL
If you use Internet Explorer or Netscape,
Windows will not let you make Internet
Mail or Netscape Mail your default mail
program. There is a way, however, to
change to one of these as your default
mail program, or any other program you
fancy. This involves editing the Windows
Registry. Having a backup of the registry
before continuing is strongly recom-
mended. To change your default mail pro-
gram: Click the Start  button. Click Run. In
the Open field type �regedit� and click Ok.

Once you are there, navigate your way to
folder HKEY_CLASSES_ROOT\mailto\
shell\open\command
From here, double click on the (Default)
icon. In the Value Data field, type the path
of the program you want as the new
default. Before clicking OK, type %1 after
the path. It should look something like
this: C:\Program Files\Internet Explor-
er\mail.exe %1  Simply substitute the path
for your machine, click OK and restart
Windows.

11 ERROR 403 Forbidden
Pages:
This means that you are not authorised
to view the content of this site. Proba-
bly you need to have a password-but
please don t mail the Web master with
a request unless the site says you can.

22 ERROR 404 Not Found:
The commonest of them all. This irri-
tating message means that the site
you are looking for cannot be located.
If you get this message, there is a little
trick you can do to help locate the
missing file. Let us assume that you
attempted to go to
w w w.mysite.com/pics/cool/cindy.html.
If you receive an error message saying
it cannot find that Web site, try going
back to the root of the Web site to try
and locate the site that you are looking
for. For example, attempt to go to
w w w.mysite.com/pics/cool. You may
be able to find a link for your page
from there. And if that doesn t work, try

going to www.mysite.com/pics, and
finally www.mysite.com. You should
have a good chance of locating the
site you are looking for from one of
those sites if it has been moved or
renamed. If it has been deleted, how-
ever, you are out of luck.
.
33 ERROR 503 Service
Unavailable: This means that nor-
mally, the page would be there, but
there is a temporary problem. Try again
in a minute or so.

44  Host Unknown:This means that
the host you tried to reach is unavail-
able, and that there is no forwarding
address. Check out
http://www.4domains.com to see if it is
a valid site.

55 Too Many Connections
Try Again Later: This one is pretty
self-explanatory. Just click reload or
refresh till you get to where you want to

Ever wondered what all those HTTP 404 not found  mes-
sages mean? Here are the six most commonly found error
messages on the Web, and their explanations

ERRONEOUS ZONES6
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about punctuation. 

Phrase it right
You�ll get better results if you enter a few
related words rather than a single word.
Thus, if you want to get complete low-
down on King Arthur and his gallivanting
knights, searching for �king arthur excal-
ibur lancelot galahad guinevere� will be
more effective than simply �arthur�. You
may also enter a question: �Who found

the holy grail?� Most search engines
ignore words like �the� and �a� anyway. 

Persistence pays
If you don�t glean what you�re looking for
on the first try, click again. Try varying
the original query by substituting syn-
onyms or related words. Too many
results? Add descriptive terms to make
your query more precise. 

Boolean logic
Go through your search engine�s help
pages and search tips entirely at least
once to optimally refine your searches.
Use Boolean operators such as AND, OR
and NOT to narrow down results. Use
keywords you think would be unique to
the results required. 

Don�t use terms that are too common.
For example, searching for just �computers�
might leave you pointing to about 25 per-
cent of the Web! But searching for Educa-
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One way to prevent spam�those annoying e-
mails sent in bulk�is to simply add a word to
your e-mail address. For example, if your e-mail
address is nerd@chip-india.com, you could tell
a newsgroup without batting an eyelid that your
address is nerd@DELETEME.chip-india.com.
A person will see that your e-mail address is
wrong, but an automatic e-mail address col-
lector can never know. Hopefully, this simple
step should eliminate a significant amount of
spam. Further, you could add a little note at the
bottom that says �remove the DELETEME
before replying�, just in case there are idiots
who take it to be a legitimate part of your e-mail
ID� but then, you wouldn�t want such people
writing to you in the first place, would you?

SPAM SUCKS
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tion AND Computers
AND India will give you
results that are much
more precise. 

A question of refinement
Use search engines that allow you to fur-
ther refine your search after the results are
displayed. Any search engine worth its
name should provide advanced search
options to help you fine-tune your query.
Though each search engine is unique,
most let you search by file type, location
or domain name, date, and language. 

Infoseek, for example, gives an option

to �Find similar pages�. With HotBot, you
can use metawords to put the search
engine�s nontext search features to work.
A simple metaword search looks like this:
keyword:value. For example, to find a page
with a picture of Elton John on it, type fea-
ture:image +elton.

Meta is better
Give preferences to meta search

engines (Metacrawler, for example)
since they search multiple search engines
simultaneously. This gives better results
than if you were to search with just one or
two search engines. You can also use util-

ities such as WebFerret and Naviscope
to do more comprehensive and faster
searches. Web Ferret uses other search
engines and presents you with com-
piled results. Naviscope is a browser
enhancement which speeds up Web

searches by downloading the next page for
search results while you are viewing the
first page. When you click the �Next� but-
ton, the page is displayed instantaneously.

Take the expressway
For slow connections, metasearch sites
can take longer to return results. You
don�t need to invest in a faster modem;
you can speed up your search and boost
the number of on-target results with
Express from Infoseek.

Go wild with wildcards
You can make use of wildcards like * (aster-
isk) while searching for something on the
Net. Be careful, though. Looking for ant*,
for instance, gets you to sites dealing with
anteaters as well as anthropologists.

Ring for the Butler
Sometimes the easiest way to find some-
thing is simply to ask for it. That�s where
Ask Jeeves comes in: ask him a question
and Jeeves returns a number of customis-
able options for homing in on the informa-
tion you are looking for. For example, when
you type in a question and click on Ask, you
get your answer and/or a series of links that
answer similar queries. Jeeves also returns
matches from the top search engines.

Bang on target
Use a dead-on search result to find hid-
den keywords by peeking at a Web
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Yahoo is a great search engine. 
However, for most searches it may be
too good�it will bring up sites no matter
how old they may be. You can reduce the
return of your searches by limiting them
to return only the more recent pages 
relevant to the subject. To do this,
click on Options (right next to the
search button). You can limit your
searches by whatever length of
time you want.

STAY FRESH

Hotmail and some other Web
services ask you to provide a
question and an answer when
you sign up. If you forget your
password, they�ll ask you the
question to verify your identity.
But any joker with a Web
browser can view your ques-
tion�so don�t use one with an
easy answer that even casual
acquaintances might know
(girlfriend�s name or your
favourite dessert, for exam-
ple). After all, this is just like a
password to your password.
And so, we do not recommend
that you use the example sug-
gested alongside� ;-)

QUESTION CAREFULLY
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page�s source code. To view a page�s
HTML in Microsoft Internet Explorer,
select Source from the View menu. This
opens the page in Notepad. Use Internet
Explorer or Netscape Navigator to go to
the View menu and select Page Source.
HTML metatags look like this: <META
NAME= keywords  CONTENT= pub-
lishing, magazine, Internet, pc, chip,
computers >. You will now know what
other words to include in your search
string, in order to bring up more pages
like this one.

The mail of the species...
E-mail is the most widely-used application
of the Internet. It is also the most abused.
Forget e-mail etiquette, few of us even
bother to take advantage of the many 
features built into the e-mail packages 
we use. Make it a practice to use such 
features as bcc (blind carbon copy) and
spam filter options to get the most out of
your e-mail program.

Offline is best
Always read and compose mail offline.
Connect briefly to the Internet, download
your mail, disconnect. Read and reply at
leisure, and then re-connect and send
your messages. Of course, this may be dif-
ficult for those with problems connecting
to their servers. If you have to dial a dozen
times before getting connected to your
ISP, you can configure your e-mail pro-
gram (say, Eudora) to connect automati-
cally at a predetermined time and send
and receive mail. You can set this function
for late night or early morning, so that
connection is easy and uploading and
downloading fast. Alternatively, you can
let the program do it in the background,
while you work on something else.

Open a �Spam Box�
Okay, so you have implemented the pre-
vious suggestion. Still, it is impossible to
avoid unsolicited mail completely if you
sign up for free Web services. However,
you can avoid cluttering up your Inbox by

using a free e-mail service (from Yahoo,
Hotmail or iName) to sign up for these
Web services. Do not use your primary 
e-mail account�the vsnl.net.in account�
at any cost.

HARIKRISHNAN MENON and
VEER KOTHARI

When you register for free Web stuff, keep your eyes open for a check box that gives the site
(and its partners) a free hand to pelt you with e-mailed Special Offers. More often than not, these
special offers will turn out to be tiresome advertisements. Feel free to deselect it. Anyway, most
of these �special offers� are invalid in India.

THANKS, BUT NO THANKS
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